# Contents

<table>
<thead>
<tr>
<th>Contents</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Introduction</td>
<td>4</td>
</tr>
<tr>
<td>2. System and Loads</td>
<td>5</td>
</tr>
<tr>
<td>2.1 Sketch of System</td>
<td>5</td>
</tr>
<tr>
<td>2.2 Materials, Thicknesses and Cross-Sections</td>
<td>5</td>
</tr>
<tr>
<td>2.3 Load</td>
<td>6</td>
</tr>
<tr>
<td>3. Creation of Model</td>
<td>7</td>
</tr>
<tr>
<td>3.1 Starting RFEM</td>
<td>7</td>
</tr>
<tr>
<td>3.2 Creating the Model</td>
<td>7</td>
</tr>
<tr>
<td>4. Model Data</td>
<td>8</td>
</tr>
<tr>
<td>4.1 Adjusting Work Window and Grid</td>
<td>8</td>
</tr>
<tr>
<td>4.2 Creating Surfaces</td>
<td>10</td>
</tr>
<tr>
<td>4.2.1 First Rectangular Surface</td>
<td>11</td>
</tr>
<tr>
<td>4.2.2 Second Rectangular Surface</td>
<td>12</td>
</tr>
<tr>
<td>4.3 Creating Members</td>
<td>13</td>
</tr>
<tr>
<td>4.3.1 Downstand Beams</td>
<td>13</td>
</tr>
<tr>
<td>4.3.1.1 Steel Girder</td>
<td>13</td>
</tr>
<tr>
<td>4.3.1.2 T-Beams</td>
<td>15</td>
</tr>
<tr>
<td>4.3.2 Columns</td>
<td>17</td>
</tr>
<tr>
<td>4.4 Support Arrangement</td>
<td>21</td>
</tr>
<tr>
<td>4.5 Connecting Member with Hinge and Eccentricity</td>
<td>23</td>
</tr>
<tr>
<td>4.5.1 Hinge</td>
<td>23</td>
</tr>
<tr>
<td>4.5.2 Member Eccentricity</td>
<td>24</td>
</tr>
<tr>
<td>4.6 Checking the input</td>
<td>25</td>
</tr>
<tr>
<td>5. Loads</td>
<td>26</td>
</tr>
<tr>
<td>5.1 Load Case 1: Self-Weight and Finishes</td>
<td>27</td>
</tr>
<tr>
<td>5.1.1 Self-Weight</td>
<td>28</td>
</tr>
<tr>
<td>5.1.2 Floor Structure</td>
<td>28</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Contents</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.2 Load Case 2: Live Load, Area 1</td>
<td>29</td>
</tr>
<tr>
<td>5.3 Load Case 3: Live Load, Area 2</td>
<td>31</td>
</tr>
<tr>
<td>5.3.1 Surface Load</td>
<td>31</td>
</tr>
<tr>
<td>5.3.2 Line Load</td>
<td>32</td>
</tr>
<tr>
<td>5.4 Load Case 4: Wind</td>
<td>33</td>
</tr>
<tr>
<td>5.5 Checking Load Cases</td>
<td>35</td>
</tr>
<tr>
<td>6. Combination of Load Cases</td>
<td>36</td>
</tr>
<tr>
<td>6.1 Creating Load Combinations</td>
<td>36</td>
</tr>
<tr>
<td>6.2 Creating Result Combinations</td>
<td>39</td>
</tr>
<tr>
<td>7. Calculation</td>
<td>40</td>
</tr>
<tr>
<td>7.1 Checking Input Data</td>
<td>40</td>
</tr>
<tr>
<td>7.2 Generating the FE Mesh</td>
<td>41</td>
</tr>
<tr>
<td>7.3 Calculating the Model</td>
<td>41</td>
</tr>
<tr>
<td>8. Results</td>
<td>42</td>
</tr>
<tr>
<td>8.1 Graphical Results</td>
<td>42</td>
</tr>
<tr>
<td>8.2 Results Tables</td>
<td>44</td>
</tr>
<tr>
<td>8.3 Filter Results</td>
<td>45</td>
</tr>
<tr>
<td>8.3.1 Visibilities</td>
<td>45</td>
</tr>
<tr>
<td>8.3.2 Results on Objects</td>
<td>47</td>
</tr>
<tr>
<td>9. Display of Result Diagrams</td>
<td>48</td>
</tr>
<tr>
<td>9.1 Documentation</td>
<td>49</td>
</tr>
<tr>
<td>9.2 Creation of Printout Report</td>
<td>49</td>
</tr>
<tr>
<td>9.3 Adjusting the Printout Report</td>
<td>50</td>
</tr>
<tr>
<td>9.4 Inserting Graphics in Printout Report</td>
<td>51</td>
</tr>
<tr>
<td>10. Outlook</td>
<td>54</td>
</tr>
</tbody>
</table>
1. Introduction

With the following introductory example we would like to make you acquainted with the most important features of RFEM. Often you have several options to achieve your targets. Depending on the situation and your preferences, you can play with the software to learn more about the possibilities of the program. With this simple example we want to encourage you to find out useful functions in RFEM.

We will model a floor slab supported by columns including two downstand beams. Then, we will design the structure according to linear-static and second-order analysis with regard to the following load cases: self-weight with finishes, live load, wind. With the features presented we want to show you how you can define model and load objects in various ways.

With the 90-day trial version, you can work on the model without any restriction. After that period, the demo mode will be applied. You can still enter the example and calculate it; saving data will not be possible, however.

It is easier to enter data if you use two screens, or you may print this description to avoid switching between the displays of PDF file and RFEM input.

The text of the manual shows the described buttons in square brackets, for example [Apply]. At the same time, they are pictured on the left. In addition, expressions used in dialog boxes, tables and menus are set in italics to clarify the explanations. Input required is written in bold letters.

You can look up the description of program functions in the RFEM manual that you can download on the Dlubal website.
2. System and Loads

2.1 Sketch of System

![Structural System Diagram]

Figure 2.1: Structural system

The reinforced concrete floor consists of two continuous floor slabs with a downstand beam made of reinforced concrete and another one made of steel. The construction is supported by columns which are bending-resistant and integrated into the plate.

As mentioned above, the model represents an "abstract" structure that can be designed also with the demo version whose functions are restricted to a maximum of two surfaces and twelve members.

2.2 Materials, Thicknesses and Cross-Sections

We use concrete $f'c = 4000$ psi and steel A992 as materials.

The floor thickness is 8 in. The concrete columns and the downstand beam consist of square cross-sections with a lateral length of 12 in. For the steel beam we use a W 18x50 section.
2.3 Load

**Load case 1: Self-weight and finishes (permanent load)**
As loads, the self-weight of the model including its floor structure of 15 psf is applied. We do not need to determine the self-weight manually. RFEM calculates the weight automatically from the defined materials, surface thicknesses and cross-sections.

**Load case 2: Live load, area 1**
The floor surface represents a domestic area with a live load of 30 psf. The load is applied in two different load cases to cover the effects of continuity.

**Load case 3: Live load, area 2**
The live load of 30 psf is also applied to the second field. In addition, a vertically acting linear load of 350 lbf/ft is taken into account on the edge of the floor, representing a loading due to a balcony construction.

**Load case 4: Wind in -Y**
For the wind loads of the walls (not contained in our model), we have to allocate the surface loads to the lines of the floor and ceiling slabs. The forces acting on the floor shall not be taken into account in this example.

The line loads for the ceiling are:
\[
\frac{1}{2} \cdot 10 \text{ psf} \cdot 13 \text{ ft} = 65 \text{ lbf/ft} \quad \text{(for line 4)}
\]
\[
\frac{1}{2} \cdot 10 \text{ psf} \cdot 10 \text{ ft} = 50 \text{ lbf/ft} \quad \text{(for line 8)}
\]
\[
\frac{1}{2} \cdot 8 \text{ psf} \cdot 13 \text{ ft} = 52 \text{ lbf/ft} \quad \text{(for line 2)}
\]
\[
\frac{1}{2} \cdot 8 \text{ psf} \cdot 10 \text{ ft} = 40 \text{ lbf/ft} \quad \text{(for line 6)}
\]
3. Creation of Model

3.1 Starting RFEM

To start RFEM in the taskbar, we click Start, point to All Programs and Dlubal, and then we select Dlubal RFEM 5.xx or we double-click the Dlubal RFEM 5.xx icon on the computer desktop.

3.2 Creating the Model

The RFEM work window opens showing us the dialog box below. We are asked to enter the basic data for the new model.

If RFEM already displays a model, we close it by clicking Close on the File menu. Then, we open the General Data dialog box by clicking New on the File menu.

We write Introductory Example in the Model Name box. To the right, we enter Floor Slab on Columns in the Description box. We always have to define a Model Name because it determines the name of the RFEM file. The Description box does not necessarily need to be filled in.

In the Project Name box, we select Examples from the list if not already set by default. The project Description and the corresponding Folder are displayed automatically.

In the dialog section Type of Model, the 3D option is preset. This setting enables spatial modeling. We check whether the Positive Orientation of the Global Axis Z is Upward and – by clicking the [Details] button – the Orientation of the Local z-Axis goes Downward.

We check as well if the Standard ACI 318-14 is selected in the section Classification of Load Cases and Combinations. If not, we select this entry from the drop down list.

Now, the general data for the model is defined. We close the dialog box by clicking [OK].
4. Model Data

4.1 Adjusting Work Window and Grid

The empty work window of RFEM is displayed.

View

First, we click the [Maximize] button on the title bar to enlarge the work window. We see the axes of coordinates with the global directions X, Y and Z displayed in the workspace.

To change the position of the axes of coordinates, we click the [Move, Zoom, Rotate] button in the toolbar above. The pointer turns into a hand. Now, we can position the workspace according to our preferences by moving the pointer and holding the left mouse button down.

Furthermore, we can use the hand to zoom or rotate the view:

- Zoom: We move the pointer and hold the [Shift] key down.
- Rotation: We move the pointer and hold the [Ctrl] key down.

To exit the function, different ways are possible:

- We click the button once again.
- We press the [Esc] key on the keyboard.
- We right-click into the workspace.

Mouse functions

The mouse functions follow the general standards for Windows applications. To select an object for further editing, we click it once with the left mouse button. We double-click the object when we want to open its dialog box for editing.

When we click an object with the right mouse button, its shortcut menu appears showing us object-related commands and functions.

To change the size of the displayed model, we use the wheel button of the mouse. By holding down the wheel button we can shift the model directly. When we press the [Ctrl] key additionally, we can rotate the structure. Rotating the structure is also possible by using the wheel button and holding down the right mouse button at the same time. The pointer symbols shown on the left show the selected function.
Grid

The grid forms the background of the workspace. In the dialog box *Work Plane and Grid/Snap*, we can adjust the spacing of grid points. To open the dialog box, we use the [Settings of Work Plane] button.

![Work Plane and Grid/Snap Dialog Box](image)

Later, for entering data in grid points, it is important that the *SNAP* and *GRID* options in the status bar are set as active. In this way, the grid becomes visible and the points will be snapped on the grid when clicking.

Work plane

The XY plane is set as the work plane by default. With this setting all graphically entered objects will be generated in the horizontal plane. The plane has no significance for entering data in dialog boxes or tables.

The default settings are appropriate for our example. We close the dialog box with the [OK] button and start with modeling the structure.
4.2 Creating Surfaces

It would be possible to define corner nodes first to connect them with lines which we could use to create the floor surface. But in our example we use the direct graphical input of lines and surfaces.

We can define the ceiling as a continuous surface by means of outlines. But it is also possible to represent the floor by two rectangular surfaces which are rigidly connected in a common line. The second way of modeling makes it easier to apply loads to two areas.

Before we start creating the surfaces, we activate two useful functions. For this, we use the general shortcut menu. We right-click in an empty space of the work window to activate it.

Show Numbering

You can activate and deactivate functions by clicking within the shortcut menu. Active functions are marked by buttons highlighted in yellow. We activate the entry Show Numbering.

Auto Connect Lines/Members

If the function Auto Connect Lines/Members is not active, we also activate it (please right-click again for the shortcut menu). It makes it easier to create the surfaces.
4.2.1 First Rectangular Surface

To create rectangular plates quickly, we click **Model Data** on the **Insert** menu, then we point to **Surfaces, Plane** and **Graphically** and select **Rectangle**.

or we use the corresponding list button for the selection of plane surfaces. We click the arrow button [▼] to open a menu offering a large selection of surface geometries.

With the command [Rectangular] we can define the plate directly. The related nodes and lines will be created automatically.

After selecting this function, the dialog box *New Rectangular Surface* opens.

![Figure 4.3: Dialog box New Rectangular Surface](image-url)

The **Surface No.** of the new rectangular plate is specified as 1. It is not necessary to change this number.

The **Material** is preset as Concrete $f'_c = 4000 \text{ psi}$ according to ACI 318-14. When we want to use a different material, we can select another one using the [Material Library] button.

The **Thickness** of the surface is **Constant**. We leave the value $d$ by 8 in.

In the dialog section **Surface Type** the **Stiffness** is preset appropriately with **Standard**.

We close the dialog box with the [OK] button and start the graphical definition of the slab.

We can make the surface definition easier when we set the view in -Z-direction (top view) by using the button shown on the left. The input mode will not be affected.
To define the first corner, we click with the left mouse button on the coordinate origin (coordinates X/Y/Z 0.000/0.000/0.000). The current pointer coordinates are displayed next to the reticle.

Then, we define the opposite corner of the slab by clicking the grid point with the X/Y/Z coordinates 20.00/-16.00/0.00.

RFEM creates four nodes, four lines and one surface.

### 4.2.2 Second Rectangular Surface

As the function is still active, we can define the next surface immediately.

We click node 4 with the coordinates 20.00/0.00/0.00, and then we select the grid point with the coordinates 33.00/-26.00/0.00.

As we don't want to create any more plates, we quit the input mode by pressing the [Esc] key. We can also use the right mouse button to right-click in an empty area of the work window.
4.3 Creating Members

4.3.1 Downstand Beams

We specify member properties for the lines 3 and 7 to define two downstand beams.

4.3.1.1 Steel Girder

We open the dialog box Edit Line by double-clicking line 7.

We switch to the second tab Member where we select the check box for the option Available. The dialog box New Member appears.

![New Member dialog box](image)

Figure 4.6: Dialog box New Member

It is not necessary to change the default settings. We only have to create a Cross-Section. To define the cross-section at the Member start, we click the [Library] button.

The Cross-Section Library dialog box appears (see Figure 4.7).
We click the button for I sections in the upper left part of the Cross-Section Library.

The Rolled Cross-Sections - I-Sections dialog box opens. We select the W 18x50 section from the W cross-section table. The selection is easier when AISC has been set as Filter option.

For rolled cross-sections, RFEM automatically sets the Material number 2 - Steel A992.

We click [OK] and return to the initial New Member dialog box. Now the Member start box shows the new cross-section. We close the dialog box with [OK]. We also close the Edit Line dialog box with the [OK] button. The steel girder is now displayed on the edge of the floor.
4.3.1.2 T-Beams
We define the downstand beam below the ceiling in the same way: We double-click line 3 to open the Edit Line dialog box. In the Member tab, we select the option Available (see Figure 4.6).

Definition of cross-section
The New Member dialog box opens. To define the cross-section at the Member start, we click the [Library] button again (see Figure 4.6).

In the Parametric - Massive section of the library, we select the Rectangle button. The Solid Cross-Sections - Rectangle dialog box opens where we define the width $b$ and the depth $h$ as 12 in.

![Solid Cross-Sections - Rectangle dialog box](image)

Figure 4.9: Dialog box Solid Cross-Sections - Rectangle

We can use the [Info] button to check the properties of the cross-section.

For solid cross-sections RFEM automatically sets the Material number 1 - Concrete $f_c = 4000$ psi.

We click [OK] and return to the initial New Member dialog box. Now the Member start box shows the rectangular cross-section.
Definition of rib

In RFEM a downstand beam can be modeled with the member type Rib. We just change the Member Type in the New Member dialog box: We select the entry Rib from the list.

![Figure 4.10: Changing the member type](image)

Then, we click the [Edit] button to the right of the list box to open the New Rib dialog box.

![Figure 4.11: Defining the rib](image)

We define the Position and Alignment of the Rib On +z-side of surface. This is the bottom side of the floor slab.

As Integration Width, we specify L/8 for both sides. RFEM will find the surfaces automatically.

We close all dialog boxes with the [OK] button and check the result in the work window.
### 4 Model Data

#### Changing the view

We use the toolbar button shown on the left to set the [Isometric View] because we want to display the model in a 3D graphical representation.

To adjust the display, we use the [Move, Zoom, Rotate] button (see "mouse functions", page 8). The pointer turns into a hand. When we hold down the [Ctrl] key additionally, we can rotate the model by moving the pointer.

![Figure 4.12: Model in isometric view with navigator and table entries](image)

#### Checking data in navigator and tables

All entered objects can be found in the directory tree of the Data navigator and in the tabs of the table. The entries in the navigator can be opened (like in Windows Explorer) by clicking the [+] sign. To switch between the tables, we click the individual table tabs.

For example, in the navigator entry Surfaces and in Table 1.4 Surfaces, we see the input data of both surfaces in numerical form (see figure above).

#### 4.3.2 Columns

The most comfortable way to create columns is copying the floor nodes downward by specifying particular settings for the copy process.

**Node selection**

First, we select the nodes that we want to copy. To open the corresponding dialog box, we select Select on the Edit menu, and then we click Special or we use the toolbar button shown on the left.

The Special Selection dialog box has Nodes as the category by default (see Figure 4.13). As we want to select All nodes, we can confirm that dialog box without making any additional changes by clicking [OK].
The selected nodes are now displayed with a different color. Yellow is the default selection color for black backgrounds. (If, in addition, a surface is selected, it can be removed from the selection by holding the [Ctrl] key and clicking the surface.)

**Copying nodes**

We use the button shown on the left to open the Move or Copy dialog box.

We increase the *Number of copies* to 1: With this setting the nodes won’t be moved but copied. As the columns are 10 ft high, we enter the value **-10.0 ft** for the *Displacement Vector in dz*. 
Now, we click the [Details] button to specify more settings.

![Detail Settings for Move/Rotate/Mirror](image)

In the dialog section **Connecting**, we select the check boxes for the following options:

- Create new lines between the selected nodes and their copies
- Create new members between the selected nodes and their copies

Then, we select member 2 from the list to define it as the **Template member**. Thus, the properties of the T-beam (member type, cross-section, material) are automatically set for the new columns.

We close both dialog boxes by clicking the [OK] button.

**Editing surfaces**

Because we defined the template member as a **Rib** with integration widths, we now have to adjust the member type. We choose another way for the selection of columns.

First, we set the view in the [Y] direction by using the button shown on the left.

Now, we use the pointer to draw a window from the right to the left across the footing nodes of the columns. In this way, we select all objects that are completely or only partially contained in the window, so our columns are selected as well. (When we draw the window from the left to the right, we select only those objects that are completely contained in the window).

![Selecting with window](image)
Now, we double-click one of the selected columns. The Edit Member dialog box appears. The numbers of the selected members are shown in the Member No. box.

Figure 4.17: Adjusting the member type

We change the member type to Beam and close the dialog box with the [OK] button.

Again, we set the [Isometric View] to display our model completely.

Figure 4.18: Full isometric view
4.4 Support Arrangement

The model is still without supports. In RFEM we can assign supports to nodes, lines, members and surfaces.

Assigning nodal supports

The columns are supported in all directions on their footing but are without restraints.

The foot nodes and the columns remain selected as long as we do not click in the work window. If necessary, we select those objects again by window selection (see Figure 4.16).

Now, we double-click one of the selected foot nodes. Watching the status bar in the bottom left corner we can check if the pointer is placed on the relevant node.

The Edit Node dialog box opens.

![Figure 4.19: Dialog box Edit Node, tab Support](image)

In the Support tab, we select the check box Available. With this setting we assign the Hinged support type to the selected nodes.

After clicking the [OK] button we can see the support symbols displayed in the model.

Changing the work plane

We want to correct the length of the two columns on the left to 13 ft. Therefore, we shift the work plane from the horizontal to the vertical plane.

To set the [Work Plane YZ], we click the second of the three plane buttons.

The grid is now displayed within the plane of the left columns. This setting allows us to define lines graphically or to displace nodes in this work plane.
**Adjusting support nodes**

We cancel the selection of nodes by clicking with the left mouse button into an "empty" space of the work window.

Now, we shift node 9 with the mouse by 3 ft to the grid points below. Please take care to select the node and not the member. Again, we can check the node numbers and the coordinates of the pointer in the status bar.

We repeat the same step for node 8.

Alternatively, it would be possible to double-click one of the nodes and to enter the correct Z-coordinate in the *Edit Node* dialog box.
4.5 Connecting Member with Hinge and Eccentricity

4.5.1 Hinge

The steel girder cannot transfer any bending moments to the columns because of its connection. Therefore, we have to assign hinges to both sides of the member.

We double-click member 1 to open the Edit Member dialog box.

In the Member Hinge dialog section, we click the [New] button to define a hinge type for the Member start (see also Figure 4.23).

The New Member Hinge dialog box appears in which the displacements or rotations can be selected that are released at the member end. In our example, we select the check boxes for the rotations $\phi_y$ and $\phi_z$. Thus, no bending moments can be transferred at the node.

We confirm the default settings and close the dialog box by clicking the [OK] button.

In the Edit Member dialog box we see that hinge 1 is now entered for the Member start. We define the same hinge type for the Member end by using the list (see Figure 4.23).
4.5.2 Member Eccentricity

We want to connect the steel girder eccentrically below the floor slab.

In the Edit Member dialog box, we switch to the Options tab. In the Member Eccentricity section, we click the [New] button to open the New Member Eccentricity dialog box.
We select the option *Transverse offset from cross-section of other object*. In our example, the object is the floor slab: We use the [Select] function to define **Surface 2** graphically.

Then, we define the *Cross-section alignment* as well as the *Axis offset* as shown in Figure 4.24. Please watch out the local axis system on the picture.

In the dialog section *Axial offset from adjoining members*, we select the check boxes for **Member start** and **Member end** to arrange the offset on both sides.

After confirming all dialog boxes we can check the result with a maximized view (for example zooming by rotating the wheel button, moving by holding down the wheel button, rotating by holding down the wheel button and the right mouse button).

![Figure 4.25: Steel girder with release and eccentricity](image)

**4.6 Checking the Input**

**Checking Data navigator and tables**

The graphical input is reflected in both the *Data* navigator tree and the tables. We can display and hide the navigator and tables by selecting **Navigator** or **Table** on the *View* menu. We can also use the corresponding toolbar buttons.

In the tables, structural objects are organized in numerous tabs. Graphics and tables are interactive: To find an object in the table, for example a surface, we set **Table 1.4 Surfaces** and select the surface in the work window by clicking it. We see that the corresponding table row is highlighted (see Figure 4.12, page 17).

We can check the entered numerical data quickly.

**Saving data**

Finally, the entry of model data is complete. To save our file, we select **Save** on the *File* menu

or use the toolbar button shown on the left.
5. Loads

Changing units
Before we begin, we change the units for which our structure is defined by. We navigate to Units and Decimal Places on the Options menu.

In the Units and Decimal Places dialog box, we select the Loads tab.

By default, Forces is set to kip and Area loads is set to ksf. We change these to lbf and psf in the corresponding drop down menus.

![Figure 5.1: Dialog box Units and Decimal Places](image)

We make sure that 3 decimal places are set each.

Then we click [OK] and close the dialog box.

Load cases
First, loads such as self-weight, live or wind loads are described in different load cases. In the next step, we superimpose the load cases with load factors according to specific combination rules (see Chapter 6).
5.1 Load Case 1: Self-Weight and Finishes

The first load case contains the permanently acting loads from self-weight and floor structure (see Chapter 2.3, page 6).

We use the [New Surface Load] button to create a load case.

The dialog box Edit Load Cases and Combinations appears.

Load case No. 1 is preset with the action type D Dead. In addition, we enter the Load Case Description Self-weight and finishes.
5.1.1 Self-Weight

The Self-Weight of surfaces and members in the Z-direction is automatically taken into account when the Active check box is selected and the factor is specified as -1.000 by default.

5.1.2 Floor Structure

We confirm the entry by clicking the [OK] button. The New Surface Load dialog box opens.

Figure 5.4: Dialog box New Surface Load

The floor structure is acting as load type Force, the load distribution is Uniform. We accept the default settings as well as the Global ZL setting in the Load Direction section.

In the Load Magnitude dialog section, we enter a value of -15 psf (see Chapter 2.3, page 6). Then, we close the dialog box by clicking [OK].

Now, we can assign the load graphically to the floor surface: We can see that a small load symbol has appeared next to the pointer. This symbol disappears as soon as we move the pointer across a surface. We apply the load by clicking the surfaces 1 and 2 one after the other (see Figure 5.5).

We can hide and display the load values with the toolbar button [Show Load Values].

To quit the input mode, we use the [Esc] key. We can also right-click in the empty work window. The input for the load case Self-weight and finishes is complete.
5.2  Load Case 2: Live Load, Area 1

We divide the live load of the floor into two different load cases because of the effects of continuity. To create a new load case, we point to **Loads** on the **Insert** menu and select **New Load Case** or we use the corresponding button in the toolbar (to the left of the load case list).

For the **LC Description** we enter **Live Load, Area 1**.
The Action Category is set automatically to D. Weight of Ice. We change this classification to Live in the corresponding drop down menu. The action category is important to assign the correct load factors in the combinations later.

After having confirmed the input, we enter the surface load in a new entry method: First, we select floor surface 1 by clicking. Now, when we open the dialog box by means of the [New Surface Load] button, we can see that the number of the surface is already entered.

![New Surface Load Dialog Box](image)

**Figure 5.7: Dialog box New Surface Load**

The live load is acting as load type Force, the load distribution is Uniform. We accept these default settings as well as the Global ZL setting in the Load Direction section.

In the Load Magnitude dialog section, we enter a value of **-30 psf** (see Chapter 2.3, page 6). Then, we close the dialog box by clicking [OK].

The surface load is displayed in the left area of the floor.
5.3 Load Case 3: Live Load, Area 2

We create a [New Load Case] to enter the live load of the right field.

![Image of Load Case dialog box]

Figure 5.8: Dialog box Edit Load Cases and Combinations, tab Load Cases

We enter **Live Load, Area 2** in the **Load Case Description** text box and make sure the **Action Category** has been set to **Live**. Then we close the dialog box with [OK].

### 5.3.1 Surface Load

This time we select floor surface 2 and open the dialog box **New Surface Load** with the [New Surface Load] button.

In addition to surface 2, we can see that the parameters of the recent entry are automatically set (load type **Force**, load distribution **Uniform**, load direction **Global ZL**, **Load Magnitude** -30 psf – see Figure 5.6). We can confirm the dialog box without making any changes.

The surface load is displayed in the right area of the floor (see Figure 5.9).
5.3.2 Line Load

It is easier to apply a line load to the rear edge of the floor when we maximize the display of this area by using the Zoom function or the wheel button.

With the [New Line Load] toolbar button to the left of the [New Surface Load] button we open the New Line Load dialog box.

The line load as load type Force with a Uniform load distribution acts in the ZL load direction. In the Load Parameters dialog section, we enter -350 lbf/ft (see Chapter 2.3, page 6).

![New Line Load dialog box](image)

After clicking the [OK] button we click line 8 at the floor's rear edge (check by status bar).

We close the input mode with the [Esc] button or by right-clicking in the empty workspace. Then, we reset the [Isometric View].
5.4 Load Case 4: Wind

In the last load case we define the wind load which is acting to the walls (not represented in our model).

This time, we use the Data navigator to create a new load case: We right-click the entry Load Cases to open the shortcut menu, and then we select New Load Case.

We choose Wind in -Y from the Load Case Description list. The Action Type changes automatically to Wind.

We close the dialog box by clicking the [OK] button.
We click the [New Line Load] toolbar button again to open the New Line Load dialog box.

![Figure 5.12: Dialog box New Line Load](image)

We define the Load Direction as YL and enter the force of $-65 \text{ lbf/ft}$ (see Chapter 2.3, page 6).

After [OK], we click the lines 2, 4, 6, and 8 to apply the effective wind load on the ceiling.

![Figure 5.13: Graphical input of wind loads without adjustments](image)
To adjust the loads on lines 2, 6, and 8 according to the values listed in Chapter 2.3 on page 6, we double-click each load and change the force magnitude as shown in Figure 5.14 below.

**Changing the model display**

The figure above shows the structure as *Wireframe Display Model*. We can set this display option with the toolbar button shown on the left. In this way, the imperfections are no longer overlapped by rendered columns.

### 5.5 Checking Load Cases

All four load cases have been completely entered. It is recommended to [Save] the model now.

We can check each load case quickly in the graphics: The buttons [◀] and [▶] in the toolbar allow us to select previous and subsequent load cases.

The loading’s graphical input is also reflected in both the *Data* navigator tree and the tables. We can access the load data in Table 3. *Loads* which can be set with the button shown on the left.

Again, the graphic and tables are interactive: To find a load in the table, for example a line load, we set Table 3.3 *Line Loads*, and then we select the load in the work window. We see that the pointer jumps into the corresponding row of the table.
6. **Combination of Load Cases**

According to ACI 318, we have to combine the load cases with factors. The *Action Type* specified before, when we created the load cases, makes generating combinations easier (see Figure 5.11, page 33). In this way, we can control the load factors and when combinations are created.

### 6.1 Creating Load Combinations

With our four load cases we create the following load combinations:

- \(1.2 \times \text{LC1} + 1.6 \times \text{LC2}\)  
  - Live load in area 1
- \(1.2 \times \text{LC1} + 1.6 \times \text{LC3}\)  
  - Live load in area 2
- \(1.2 \times \text{LC1} + 1.6 \times \text{LC2} + 1.6 \times \text{LC3}\)  
  - Live load in both fields
- \(1.2 \times \text{LC1} + 1.0 \times \text{LC2} + 1.0 \times \text{LC3} + 1.0 \times \text{LC4}\)  
  - Full load

We calculate the model according to nonlinear second-order analysis.

**Creating CO1**

We open the menu for [Load Cases and Combinations] and create a New Load Combination. The Edit Load Cases and Combinations dialog box appears again.

![Dialog box Edit Load Cases and Combinations, tab Load Combinations](image)

We enter **Live load in area 1** for the Load Combination Description.

Below, in the list Existing Load Cases, we click **LC1**. Then, we use the [>] button to transfer the load case to the list Load Cases in Load Combination CO on the right. We do the same with **LC2**.

LC1 and LC2 should have the coefficients 1.20 and 1.60 respectively. If the factors are not set automatically, we can change the values by left-clicking them and selecting the coefficients from the drop down menu, or by entering the values manually.
In the tab *Calculation Parameters*, we check if the *Method of Analysis* is set according to *Second-order analysis (P-Delta / P-delta)*.

Figure 6.2: Tab *Calculation Parameters*

In this tab, we can also check the specifications applied by RFEM for the calculation.

After clicking [OK], all loads contained in this load combination are shown in the model. The factors of the load cases have been considered for the values.

Figure 6.3: Loads of load combination CO1
Creating CO2
We create the second load combination in the same way: We create a [New Load Combination], but this time we enter **Live load in area 2** for the **Load Combination Description**.

The load cases which are relevant for this load combination are LC1 and LC3. Again, we use the [►] button to select them and then allocate the coefficients **1.20** and **1.60**, if necessary.

Creating CO3
To create the last load combination, we choose another way of creation: We right-click the navigator entry **Load Combinations** and select **New Load Combination** in the shortcut menu.

![Figure 6.4: Creating COs using the navigator shortcut menu](image)

We enter **Live load in both fields** for the **Load Combination Description**.

Now we select the **Existing Load Cases** LC1, LC2 and LC3 simultaneously by holding the [Ctrl] key. We use the [►] button again to transfer them to the list on the right. The factors are set automatically.

Creating CO4
To create the last load combination, we use the Table 2.5 **Load Combinations**. In column B we enter the description **Full Load** and we define the different load factors and load cases in columns D through K.

![Figure 6.5: Table 2.5 Load Combinations](image)
6 Combination of Load Cases

6.2 Creating Result Combinations

From the results of the four load combinations we create an envelope containing the positive and negative extreme values.

In the menu for [Load Cases and Combinations], we select New Result Combination. We see the Edit Load Cases and Combinations dialog box which is already familiar to us.

We choose Governing Result Combination from the Result Combination Description list.

To display the load combinations in the dialog section Existing Loading, we select CO Load Combinations from the list below the load table on the left. Then, we select all four load combinations by clicking the [Select All Listed Loading] button.

The selection box below the load table on the right indicates the superposition factor which is preset to 1.00. The setting conforms to our intention to determine the extreme values of this load combination. We change the superposition rule to Permanent in the list for all load combinations. Thus, RFEM always takes into account at least one of the actions.

We use the [Add Selected with ‘or’] button to transfer the four load combinations to the list on the right. The value 1 below the final column tells us that all entries belong to the same group: They won’t be treated as additive but alternatively acting.

Now, the superposition criteria is completely defined. We click [OK] and [Save] the entry.
7. Calculation

7.1 Checking Input Data

Before we calculate our structure, we want RFEM to check our structural and load data. To open the corresponding dialog box, we select **Plausibility Check** on the **Tools** menu. The **Plausibility Check** dialog box opens where we define the following settings.

![Dialog box Plausibility Check](image)

If no error is detected after clicking [OK], the following message is displayed. In addition, a short summary of structural and load data is shown.

![Result of plausibility check](image)

We find more tools for checking the structural and load data by selecting **Model Check** on the **Tools** menu.
7 Calculation

7.2 Generating the FE Mesh

As we have selected the option Generate FE mesh in the Plausibility Check dialog box (see Figure 7.1), we have automatically generated a mesh with the standard mesh size of 1 ft.

![Figure 7.3: Model with generated FE mesh](image)

The mesh size can be modified by selecting FE Mesh Settings on the Calculate menu.

7.3 Calculating the Model

To start the calculation, we select Calculate All on the Calculate menu or we use the toolbar button shown on the left.

![Figure 7.4: Calculation process](image)
8. Results

8.1 Graphical Results

As soon as the calculation is finished, RFEM displays the deformations of the load case currently set. The last load setting was RC1, so now we see the maximum and minimum results of this result combination.

Figure 8.1: Graphic of max/min deformations for result combination RC1

Selecting load cases and load combinations

We can use the toolbar buttons [▲] and [▼] (to the right of the load case list) to switch between the results of load cases, load combinations and result combinations. We already know the buttons from checking the load cases. It is also possible to select the loads in the list.

Figure 8.2: Load case list in the toolbar

Selecting results in the navigator

A new navigator has appeared which manages all result types for the graphical display. We can access the Results navigator when the results display is active. We can switch the results display on and off in the Display navigator, but we can also use the toolbar button [Show Results] shown on the left.
The check boxes for the individual results categories (e.g. Global Deformations, Members, Surfaces, Support Reactions) determine which deformations or internal forces are shown. Within these categories are even more individual types of results that we can select for display.

Finally, we can browse the single load cases and load combinations. The various result categories allow us to display deformations, internal forces of members and surfaces, stresses or support forces.

![Results](image)

**Figure 8.3: Setting internal forces of members and surfaces in Results navigator**

In the figure above, we see the member internal forces $M_i$ and the surface internal forces $m_i$ calculated for CO1. To display the forces, it is recommended to use the wire-frame model. We can set this display option with the button shown on the left.

**Display of values**

The control panel shows us the color ranges. We can switch on the result values by selecting the option **Values on Surfaces** in the Results navigator. To display all values of the FE mesh nodes or grid points, we clear the selection for **Extreme Values** additionally.

![Values](image)

**Figure 8.4: Grid point moments $m_o$ of floor slab in -Z-view (CO1)**
8 Results

8.2 Results Tables

We can also evaluate results in tables. The results tables are displayed automatically when the model has been calculated. Like for the numerical input we see different tables with results. Table 4.0 Results - Summary gives a summary of the calculation process, sorted by load cases and combinations.

Figure 8.5: Table 4.0 Results - Summary

To select other tables, we click the corresponding table tabs. To find specific results in the table, for example the internal forces of floor surface 1, we set Table 4.15 Surfaces - Basic Internal Forces. Now, we select the surface in the graphic (the transparent model representation makes the selection easier) and we see that RFEM jumps to the surface’s basic internal forces in the table. The current grid point, that means the position of the pointer in the table row, is indicated by an arrow in the graphic.

Figure 8.6: Surface internal forces in Table 4.15 and marker of current grid point in the model

Like the browsing function in the main toolbar, we can use the arrow buttons [●] and [▼] to select a load case or combination in the table. We can also use the list in the table toolbar.
8.3 Filter Results

RFEM offers us different ways and tools by which we can represent and evaluate results in clearly-structured overviews. We can use these tools also for our example.

We display the member internal force $M_y$ in the Results navigator. We deactivate the display of the internal forces in surfaces as well as the values on surfaces (see figure on the left).

8.3.1 Visibilities

Partial views and sections can be used as so-called Visibilities in order to evaluate results.

Results display for concrete columns

We click the Views tab in the navigator. We select the following entries listed under Generated:

- Members sorted by cross-section: 2 - Rectangle 12/12
- Members sorted by type: Beam

In addition, we create the intersection of both options with the [Show Intersection] button.

![Figure 8.7: Moments $M_y$ of concrete columns in scaled representation](image)

The display shows the concrete columns including results. The remaining model is displayed lighter and without results.

Adjusting the scaling factor

For a better view of the diagrams of internal forces on the rendered model, we scale the display in the control tab of the panel: We set the factor for Member diagrams to 2 (see figure above).
Results display of floor slab

In the same way, we can filter surface results in the Views navigator. We deactivate the options Members by Cross-Section and Members by Type and select Surfaces by Thickness where we select the entry 8 in.

![Figure 8.8: Shear forces of floor](image)

As already described, we can change the display of result types in the Results navigator (see Figure 8.3, page 43). The figure above shows the distribution of the shear forces v_y for CO1.
8.3.2 Results on Objects

Another possibility to filter results is using the filter tab of the control panel where we can specify numbers of particular members or surfaces to display their results exclusively. In contrast to the visibility function, the model will be displayed completely in the graphic.

First, we clear the selection for Visibilities in the Views navigator.

![Figure 8.9: Resetting the overall view in Views navigator](image)

We select surface 1 with one click. Then, in the panel, we change to the filter tab and check if Surfaces is selected.

We click the [Import from Selection] button and see that the number of the selected surface has been entered into the box above. Now, the graphic shows only the results of the left surface.

![Figure 8.10: Shear force diagram of left surface](image)

We use the panel option All to reset the full display of results.
8.4 Display of Result Diagrams

Results can also be evaluated in a diagram which is available for lines, members, line supports, and sections. We use this function to check on the results of the T-beam.

We right-click member 2 (in case of problems we switch off the surface results) and select the Result Diagrams option.

A new window opens in which the result diagrams of the rib member are displayed.

In the navigator, we select the check boxes for the global deformations $u$ and the internal forces $M_y$ and $V_z$. The latter represents the longitudinal shear force between surface and member. Those forces are displayed when the [Results with Ribs Component] button is set active in the toolbar. When we click the button to turn it on and off, we can see the difference between pure member internal forces and rib internal forces with integration components from the surfaces.

We can use the $[+]$ and $[-]$ buttons to adjust the size of the displayed result diagrams.

The $[<]$ and $[>]$ arrow buttons to select a load case are also available in the result diagram window. We can also use the drop-down list to set the results of a load case or combination.

We quit the Result Diagrams function by closing the window.
9. Documentation

9.1 Creation of Printout Report

It is not recommended to send the complex results output of an FE calculation directly to the printer. Therefore, RFEM generates a print preview first, which is called the "printout report" containing input and result data. We use the report to determine the data that we want to include in the printout. Moreover, we can add graphics, descriptions or scans.

To open the printout report,

we select **Open Printout Report** on the **File** menu

or we use the button shown on the left. A dialog box appears where we can specify a **Template** as a sample for the new printout report.

![Figure 9.1: Dialog box New Printout Report](image)

We accept template 1 - **Input data and reduced results** and generate the print preview with **[OK]**.

![Figure 9.2: Print preview in printout report](image)
9.2 Adjusting the Printout Report

The printout report has a navigator, too. It lists the chapters that are selected for printing. When we right-click an entry, we can see the corresponding contents in the window to the right.

The default selection can be modified or specified in detail. We adjust the output of the member internal forces: Under Results - Result Combinations, we right-click Cross-Sections - Internal Forces, and then we click Selection.

![Shortcut menu Cross-Sections - Internal Forces](image)

A dialog box appears with specific options to select the RC Results.

![Reducing output of internal forces by means of Printout Report Selection](image)

We place the pointer in table cell 4.12 Cross Sections - Internal Forces. The [...] button becomes active. It opens the dialog box Details - Internal Forces by Cross-Section. There we reduce the output to the Extreme values of the internal forces N, Vz, and My.
When having confirmed the dialog box, we see that the table of internal forces has been updated in the printout report. We can adjust other chapters for the printout in the same way.

To change the position of a chapter in the printout report, we can move it to the new position using the drag-and-drop function. To delete a chapter, we can use its shortcut menu (see Figure 9.3) or the [Del] key of the keyboard.

9.3 Inserting Graphics in Printout Report

Often, we integrate graphics in the printout to illustrate the documentation.

**Printing deformation graphics**

We close the printout report with the [X] button. The program asks us *Do you want to save the printout report?* We confirm this query and return to the work window of RFEM.

In the work window, we set the *Deformation of CO1 - Live load load in area 1* and put the graphic in an appropriate position.

As deformations can be displayed more clearly as *Wireframe Display Model*, we set the corresponding display option.

Unless not already set, we change the display to *All surfaces in the filter tab of the panel*.

![Deformations of CO1](image.png)

Figure 9.5: Deformations of CO1

Now, we transfer this graphical representation to the printout report.

- We select **Print Graphic** on the **File** menu
- or use the toolbar button shown on the left.
We set the following print parameters in the Graphic Printout dialog box. It is not necessary to change the default settings in the Options and Color Spectrum tabs.

![Graphic Printout dialog box](image)

Figure 9.6: Dialog box Graphic Printout

We click [OK] to print the deformation graphic to the printout report.

The graphic appears at the end of chapter Results - Load Cases, Load Combinations.

![Deformation graphic in printout report](image)

Figure 9.7: Deformation graphic in printout report
Printing the printout report

When the printout report is completely prepared, we can send it to the printer by using the [Print] button.

The PDF print device integrated in RFEM makes it possible to save report data as a PDF file. To activate the function, we select Export to PDF on the File menu.

In the Windows dialog box Save As, we enter file name and storage location.

By clicking the [Save] button we create a PDF file with bookmarks. They facilitate navigating in the digital document.

![Figure 9.8: Printout report as PDF file with bookmarks](image)
10. **Outlook**

Now we have reached the end of the introductory example. We hope that this short introduction helps you to get started with RFEM and makes you curious to discover more of the program functions. You can find the detailed program description in the RFEM manual that you can download on our website. On the downloads and info page, you can also find a Tutorial which describes more comprehensive program functions.

With the Help menu or the [F1] key it is possible to open the online help system of the program where you can search for particular terms like in the manual. The help system is based on the RFEM manual.

Finally, if you have any questions, you are welcome to use our free e-mail hotline or consult the FAQ or Knowledge Base pages on our website.

This example can be continued in the add-on modules, for example for steel and reinforced concrete design (RF-STEEL Members, RF-CONCRETE Surfaces/Members). In this way, you will be able to perform further design, getting an insight into the functionality of the various add-on modules. Last but not least, you can evaluate the design results of those add-on modules in the RFEM work window.